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FEBRUARY 2021                                                                                                                           No. 292 

RECOGNITION FOR BRIAN 
LIFE MEMBERSHIP FOR BRIAN CUDBY 

 

Brian and his wife Pat have been members since 2007 

and Brian for many of those years taught Photoshop, 

Photoshop Elements and ProShow Gold – his expertise 

in Photoshop went way beyond the standard “how to” 

and he came up with some stunning and interesting 

results.  We also benefited from his good “eye” for a 

photograph – he had countless opportunities during his 

and Pat’s travels to capture fantastic memories. 

 

Brian is Past President of the Auckland Photographic 

Society and a life member and also became president 

of the Photographic Society of NZ. 

 

Brian’s background was in the New Zealand Army 

where he rose to the rank of Lt Colonel, served in 

Malaysia and was also Director of Intelligence in the 

Army but retired to join Air New Zealand.   

 

We were very pleased to add to Brian’s “badges” by 

presenting him with a further one – that of Life 

Member of SeniorNet North Shore for the many hours 

of preparation for your tutoring sessions and overall 

involvement and support in our club.  
(see Brian’s response page 9 ) 

 

 
Lois Kay (left) with Brian Cudby (right) after presentation 

 

 

 

 

 

 

NEW NEWS 
TOWARDS THE FUTURE UPDATE 

 

 

 

 

 

 

 

 

 

 

 

 

 

New members 

 

NEW MEMBERS 
WELCOME TO SENIORNET NORTH SHORE 

 

Nola Hughes  

Raewyn and Hugh Nettleton  

Malcolm Sharpe  

Anne Young 

Graeme Skinner 

 

 

 

 

 

 

NEXT SUNDAY SPEAKERS 
IAN BALME & GLEN PLAISTOWE 

 

 

 

 

 

 

 

 

 

 

 

 

The team met this week to 

consider ideas that will help the 

club advance into the next 

millennia – Some of these 

include looking at ways we run 

our sessions, bringing computer 

related hobbies and pastimes 

into the mix and much more. 

 

 

 

Our first speaker is Ian Balme, 

founder of Forgotten World 

Adventures and entrepreneur who 

will share his business journey and 

the keys to his success. 

 

 

 

Ian will be followed by Glen 

Plaistowe who will give an exciting 

talk about “Do you remember the 

1960’s?” 
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CLUB DIRECTORY 
 

WEBSITE www.seniornetns.com 

EMAIL snetns@xtra.co.nz 

TELEPHONE 486 2163 

CLASSES Learning Centre, Suite 3, St John Ambulance Building, 2 Shea Terrace, Takapuna 

MEETINGS 2nd Sunday of each month, 10 am in the Hall, St John, 2 Shea Terrace, Takapuna 

CONTACT The Secretary, SeniorNet NS Inc., PO Box 65 357, Mairangi Bay, Auckland 0754 

 

 

 

 

 

 

 

 

 

 

COMMITTEE & SUPPORT TEAMS 
2021 

 

CHAIRPERSON Lois Kay lois.kay@xtra.co.nz 478 3587 

SECRETARY T.B.A.   

TREASURER Norma Olliver norma.olliver@outlook.com 443 6233 

MINUTE SECRETARY Patricia Lough loughie@outlook.co.nz 021 268 8677 

MEMBERSHIP Patricia Lough loughie@outlook.co.nz 413 6322 

WEBMASTER Ian Handricks ianhandricks@gmail.com 029 477 4491 

TECHNICAL Allan White moele@xtra.co.nz 441 9344 

SPECIAL PROJECTS Campbell Stanford camstan69@gmail.com 021 717 008 

SUPERVISOR Shirley Hansen ray.shirley@xtra.co.nz 444 6946 

COMMITTEE TBA   

AUDITOR Bernard Layburn   

PROOF READER Val Sutcliffe   

NEWSLETTER Ian Handricks seniornet.newsletter@gmail.com 029 477 4491 

CONSTITUTION Peter Patten   

REFRESHMENTS Shirley Hansen and volunteers   

FUTURE GROUP Lois, Ian, Patricia, Norma, Cherry, Campbell, Jurgen   
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CHAIR REPORT 
FEBRUARY 2021 

 

At our Sunday Meeting we were very pleased to acknowledge the considerable contribution that 

Brian Cudby has made to our Club over many years – more information within this newsletter.  

Good news for our much loved member Rhoda Fraser – Rhoda has 

moved to New Plymouth (her hometown) but sad news for her many 

friends at SeniorNet North Shore where she has been a loyal 

member for 20 years.  Rhoda will have the backup of family 

members in New Plymouth but has promised to time her Auckland 

trips so she can visit us. Those of us who had the opportunity to mix with Rhoda will 

know of her love of Genealogy and Gardening and we will miss her. 

Ian Handricks has been beavering away again and redesigned the way our Newsletters 

are accessible on our website.  Do have a look - the issues date right back to 2011 and apart from all the newsy items 

there is a multitude of helpful articles within.  Each month we are provided with technical updates from Melson Lee of 

Tekzone and from Advanced Computers who along with Rowan Cammell support our newsletter financially.  

January saw the first of our Handcraft and Stitching Group – this proved immensely popular.  Our “teacher” Cherry 

Parker is well known in our club for her informative sessions.  We had a lot of laughs and in the process evoked a lot of 

memories – see photographs.   

Regretfully our proof reader of many years, Martin Watson, has resigned to concentrate on some health issues – Martin 

was thanked in an appropriate manner.  Once more Val Sutcliffe has put up her hand to take on a role strange to her 

and we are grateful to her with Mrs Layburn our back up.    

Jurgen Schubert has now had one month as our Sunday Speaker Organiser and has formatted some new methods and 

systems to provide us with interesting new ideas for our information and entertainment.  He is working closely with the 

Toward the Future Group and we value his ideas and clarity of purpose. 

Look out for incremental changes in how we operate and what we offer our members.  We 

have had a flurry of new members already this year and feel this is partially brought about 

by the need to have internet access – particularly for banking purposes.  We welcome new 

members so if you have a friend or relative that needs new computer skills bring them as a 

guest to see how we operate, introduce them to me or a committee member, and meet 

some like-minded people.  (Some working sessions need to be booked with the Tutor – 

please refer to our schedule). 

We are looking forward to an innovative year with some novel ideas.  Join us in the fun.  

Remember lock-down?  If you have internet access you have association and entertainment. 

Lois Kay 
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CALENDAR 
FEBRUARY 2021 

 

Select a class, discussion group or tutorial that appeals from the tutor notes on pages 6 to 8.  

 

This calendar details date, time and venue for activities, including type, cost and whether it is necessary to book (if 

booking is required please contact the tutor). Pay at door. All welcome.  

 

Monthly meetings are held in the hall 10am – 12:00 noon on the 2nd Sunday of each month. Come along and listen to 

some interesting speakers. Gold coin donation appreciated. Everyone welcome.  

 

Please wear your name tag to all sessions to put a face with a name. Free refreshments are provided at all Discussion 

Groups, Tutorials, and Monthly Sunday Meetings 
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T = TUTORIALS               D = DISCUSSION GROUPS                               TIMES      AM = 10.00 to 12.00         PM = 1.00 to 3.00 

Schedule  -  February 2021

Day Date Time Session Tutor Phone Email D/T Cost
Mon 1 am Auckland Anniversary

Mon 1 pm

Tue 2 am Advanced Windows Bill Howell 478-5530 howell.trust@xtra.co.nz D $3

Tue 2 pm

Wed 3 am

Wed 3 pm

Thu 4 am

Thu 4 pm

Fri 5 am First Friday Genealogy Barbara Anderson 479-6242 b.c.anderson@xtra.co.nz D $3

Fri 5 pm

Sat 6 am Tips & Tricks Ian Handricks 029 477 4491 ianhandricks@gmail.com D $3

Sat 6 pm Waitangi Day

Sun 7 am

Sun 7 pm

Mon 8 am Photo books Bernice Hyde 483-5825 bernice52@xtra.co.nz D $3

Mon 8 pm Waitangi Day Observed

Tue 9 am Photography Rex Oddy 479-3105 rex.oddy@xtra.co.nz D $3

Tue 9 pm Committee Meeting

Wed 10 am

Wed 10 pm

Thu 11 am Ask a Tutor (Must Book) Barbara Anderson 479-6242 b.c.anderson@xtra.co.nz T $5

Thu 11 pm

Fri 12 am

Fri 12 pm Card Playing Group Campbell Stanford 021 717 008 camstan69@gmail.com D $3

Sat 13 am

Sat 13 pm

Sun 14 am Monthly Meeting 10am in hall All Members Welcome

Sun 14 pm

Mon 15 am

Mon 15 pm

Tue 16 am Advanced Windows Bill Howell 478-5530 howell.trust@xtra.co.nz D $3

Tue 16 pm

Wed 17 am Handcraft & Stitching (Must 

email for what to bring)

Cherry Parker 027 391 3810 cherry.parker@xtra.co.nz D $3

Wed 17 pm Ask a Tutor (Must Book) Glen Plaistowe 027 541 2241 glenp19925@gmail.com T $5

Thu 18 am

Thu 18 pm

Fri 19 am Genealogy Workshop Lois Kay 478-3587 lois.kay@xtra.co.nz D $3

Fri 19 pm

Sat 20 am iPhone and iPad Ian Handricks 029 477 4491 ianhandricks@gmail.com D $3

Sat 20 pm

Mon 22 am

Mon 22 pm

Tue 23 am Ask me How Toby Malcolm 021 148 1834 toby@techtutors.nz T $5

Tue 23 pm

Wed 24 am

Wed 24 pm

Thu 25 am Travel Memories Glen Plaistowe 027 541 2241 glenp19925@gmail.com D $3

Thu 25 pm Card Playing Group Campbell Stanford 021 717 008 camstan69@gmail.com D $3

Fri 26 am

Fri 26 pm

[Towards the Future Planning Group]
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TUTOR NOTES 1 
FEBRUARY 2021 

 

GENEALOGY WORKSHOP      Tutor: Lois Kay 

The first hour of our February meeting will be “orchestrated” by Ian Handricks. Ian has some new 

takes on why you might want to write a piece of your family history (or even a book).  Don’t forget 

you do not have to start out with something the size of the Encyclopaedia Britannica – it can be one 

person’s story at a time – that might be your story – leave something for your descendants, might 

stop them making up stories about you! 

 

iPHONE & iPAD       Tutor: Ian Handricks 

This forum is for anyone using Apple’s iPad and/or iPhone. Ian will cover everything from first time 

iPad and iPhone users’ problems, issues and knowledge right through to experienced users. He will 

talk about exciting developments, new apps, tips and tricks. You will learn how to manage and run 

your iPad/iPhone and at each session Ian will introduce new information on how the devices can be 

used effectively. 

 

PHOTOGRAPHY       Tutor: Rex Oddy 

Photography tutorials will include practical instruction on aspects of photography and the discussion 

of members’ photographic work.  Each month members are invited to bring along digital images or 

videos for review, that are either based on a set subject or are general interest images or both. The 

image display theme for February will be our Christmas Challenge photographs and cityscapes.  As 

always the set topic isn’t compulsory you may bring along any photos that you would like to display. 

Images limited to ten per person. 

 

1ST FRIDAY GENEALOGY      Tutor: Barbara Anderson 

This month we will discover what everyone has managed to achieve over the Christmas Break. 

Perhaps you have discovered some new treasures also to show. I have gathered some genealogy odds 

and ends to discuss and we shall I am sure with searching and problems be able to fill in the time 

quite comfortably especially with Bernice’s help and expertise as well. If you have something you 

especially would like covered please let me know. 
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TUTOR NOTES 2 
FEBRUARY 2021 

 

ADVANCED WINDOWS      Tutor: Bill Howell 

This covers WinXP onwards to Win10 on the 1st and 3rd Tuesday morning each month and features 

a lively discussion group. You ask the questions and we all participate in trying to solve the problems. 

If all else fails “AG”! The answer will be revealed to those who attend the sessions 

 

 

CARD PLAYING GROUP      Tutor: Campbell Stanford 

What a fun time cards can be! For raw beginners and card-sharps alike. Beginners are appreciating 

the comfortable pace at which they can learn and hone their skills. Great camaraderie. Currently we 

play both 500 and Euchre in each session on the 2nd Friday and 4th Thursday of each month. Come 

and try it. Beats Solitaire any day! 

 

 

ASK A TUTOR     Tutors: Glen Plaistowe & Barbara Anderson 

Book with our tutors to help you solve problems. One hour is sufficient for concentrated work. Bring 

your device, power leads and mouse (remember to charge it beforehand) and a list of the problems 

you are having also the user name and passwords you need. You must book in with the Tutor in the 

week prior to the class as only 3 or 4 Tutors are available to help and they need time to prepare for 

your session. 

 

PHOTO BOOKS   Tutor: Bernice Hyde 

The main website we use is Kroma to create a photobook 

and now we can access with an iPad, and they have new 

seamless book options. So come along and join our group 

for some tips and tricks. 
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TUTOR NOTES 3 
FEBRUARY 2021 

 

TIPS’N’TRICKS       Tutor: Ian Handricks 

A tutorial and discussion forum where you can ask questions and get answers and also learn tips and 

tricks for a wide range of computer/ipad/iphone/laptop situations. Ian will endeavour to provide 

solutions for your questions and will introduce you to a bevy of useful tips, shortcuts, hidden features, 

useful tools, actions and ways to achieve results on your computer and technology devices. Each 

session, Ian will provide you with a hot list of new ideas, tips and tricks to explore and use.  

 

TRAVEL MEMORIES       Tutor: Glen Plaistowe 

With Covid clipping our wings, we are exploring the amazing scenery and activities available in our 

own country. We also have time for nostalgia viewing the photos of our previous overseas travel. 

 

 

 

HANDCRAFT & STITCHING      Tutor: Cherry Parker 

A fun, hand stitching group with a simple new pattern to tempt you at each session. Stitching tips 

and shortcuts as well as websites of interest will be discussed. To see what I design and stitch, go to 

www.cherryparker.co.nz as similar items will be part of some classes. For sewing items to bring to 

each session, please email Cherry at cherry.parker@xtra.co.nz as these will change each month. 

 

 

ASK ME HOW       Tutor: Toby Malcolm 

This is an “ask anything” session – whether it be about Windows, Macs, the internet, smartphones, 

tablets (Apple or Android) or some other topic.  Each session will be different depending on the 

questions asked. Special Topic:  Windows 10 computer software spring cleaning. (30 minutes or so 

depending on the interest level) Top tips for spring cleaning your computer software and getting it 

in shape ready for 2021. This can help with speed, security, and overall well-being of your computer 

- your computer will love you! 
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NEWS & EVENTS 
WHAT’S ON DURING FEBRUARY 2021 

 

BRIAN CUDBY’S RESPONSE …        

Dear Lois and your committee 

I DON'T BELIEVE IT!  (To quote TV's Victor Melgrew, “One Foot in the Grave”) 

When you started talking about me at the Sunday meeting yesterday, I thought you might have 

been going to invite me to give a short contemporaneous talk about something or other, and 

was racking my brains as to what to talk about. What transpired was a complete and total 

surprise.  I was, and still remain, speechless - a little unusually. 

I joined the club, firstly to continue my computer learning process and secondly to share with and help others advance their 

knowledge within my limited range - whilst coincidentally doing the same to myself. I've thoroughly enjoyed the process, met many 

wonderful (and very clever) people had great experiences and learned an enormous amount that I would otherwise have missed 

out on. 

I cannot thank you enough and can't imagine why you've singled me out for special recognition when there are so many others who 

have contributed, and continue to contribute, more than I ever have. For me to be awarded a Life Membership is a fantastic honour, 

one which in my view is totally unearned and unjustified.  Thank you so much.  I'm still overwhelmed.  I remain at the service of the 

club in any way you may feel that I can help. My very best wishes and kind regards  -   Brian Cudby 
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SUNDAY MEETING 
REPORT OF MEETING – JANUARY 2021 

 

PETER PATTEN “SONGS MY MOTHER TAUGHT ME”       

We had two of our own take the floor for our January Sunday Meeting.  First up was Peter Patten who delved into the 

past with two headlines “Songs My Mother Taught Me” and “Things My Mother Never Taught Me”. 

Peter illustrated via YouTube some very old but invaluable clips of former serious and comedic singers and he reminded 

us of the old ZB Sunday Request sessions and the playing of items 

such as A Fruity Melodrama which his Mother had introduced to 

him.   

When it came to more recent events Peter illustrated the 

Homes.co.nz site which provides information on properties for 

sale or sold recently and in most cases it showed the price and the 

GV – a really helpful site for people interested in the property 

market.  

A further site that proved to be of great interest was Google Earth.  

Knowing how to get the best out of this can provide “endless 

entertainment” but seriously it is a very helpful tool and a number 

of our members were thrilled to be introduced to its capabilities.  

IAN ROBINSON “DOVER CASTLE” 

After morning tea Ian Robinson entertained us with an informative and colourful look at the intricacies of Dover Castle 

and talked of its impact on the area.  Dover Castle originated as a motte and bailey castle, built after the Norman 

Conquest of 1066. It was transformed by King Henry II between 1179 and 1188; building the keep, the walls of the inner 

bailey and parts of the outer curtain wall.  Dover (meaning water) was described as the “Key to England” due to its 

defensive significance throughout history.  It was famously, if ultimately unsuccessfully, besieged in 1216 by Prince Louis 

of France.  Ironically it is built entirely of Caen stone from France.  It is a beautiful castle with light creamy-yellow Jurassic 

limestone and boasts a small chapel dedicated to the memory of Thomas Beckett the murdered archbishop of 

Canterbury. 

Dover Castle was Ian’s playground and you can imagine a 

young boy enjoying the tunnels and the secrets it had to 

offer.  Ian recommends you do not go to Kent without a visit 

to Dover Castle – although you might have to wait a year or 

two. 

Thanks to our two speakers for the “entertainment”.  It was 

a very good morning. 

 

Ian Robinson & Peter Patten 



 

11 
 

SUNDAY MEETINGS 
NEXT MEETING - FEBRUARY 2021 

 

INTERESTING TALKS BY– IAN BALME & GLEN PLAISTOWE 

Ian Balme is an entrepreneur who will share his business journey and the keys to his 

success and his stories about railways, golf carts and a vision. When farmer Ian Balme 

told people he was going to start a travel attraction in central North Island, running golf 

carts on the unused railway line between Stratford and Taumarunui, they scoffed. Nine 

years later, that travel attraction – Forgotten World Adventures – now includes tours by 

rail cart, jet boat, pushbike, canoe and helicopter. It attracts over 9000 visitors a year, 

75% Kiwis and 25% international tourists.  

 

As a horizontal integration, Ian opened the Forgotten World Adventures Motel, giving 

visitors an accommodation option that encouraged them to stay longer in the area. 

Plans are afoot for a restaurant and bar to launch this year. Today, Forgotten World 

Adventures employs around 35 seasonal staff and last year, the popular attraction won the New Zealand Tourism Awards 

People’s Choice category for the second year in a row.  

 

It’s fair to say that those who initially scoffed at Ian’s idea may now have a different view. Through vision, innovation, 

and sheer determination, Ian Balme has turned his far-fetched idea into a leading tourist attraction.  

 

Aware that people are interested in his business journey and how he created a successful travel attraction in just a few 

years, Ian now travels the country, talking to groups and sharing his story. 

 

 

Ian will be followed by our own Glen Plaistowe who will give an exciting talk about “Do 

you remember the 1960’s?” 

 

Glen has run a series of very popular nostalgia sessions in the club and there are many 

requests for her to follow-up with more. (n.b. The change in the Auckland skyline 1960 on the 

left and 2020 on the right – 60 years of development) 
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THE TEXTURE OF AUCKLAND 
SOME PHOTOS TAKEN BY LOIS KAY AROUND AUCKLAND CBD WITH THE PHOTOGRAPHY GROUP  
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ADVANCED COMPUTERS 
5 STEPS TO ARCHIVE EMAILS AND KEEP OUTLOOK RUNNING STRONG 

 
Ever notice that your Microsoft Outlook account has slowed to a crawl? Basic email functions like Send/Receive acting a little funny? 

Consider checking the size of your mailbox. You might be shocked to discover just how bloated it is. For most versions of Outlook, 

clicking on File > Folder > Properties > Storage — or right-clicking on any folder and selecting Properties — will display the total size 

not only of a chosen folder but also of any associated subfolders. 

 

Outlook’s Auto Archive function is set to automatically back up Deleted Items, Sent Items, and expired tasks and calendar items. But 

if you get hundreds of messages per day and don’t delete them or move them from your Inbox, you run the risk of sabotaging your 

account. Exceed 2GB of storage in an overstuffed Inbox and Outlook really starts to run slow. 

 

Yet solving the problem is doable. Here are five (5) steps outlined below to change Auto Archive’s settings. 

 

1. Create a new local folder or .pst (Personal Folders) file to hold Archived Mail. Right click on the On My Computer heading at the 

bottom of your folder list and choose New Folder.  Name the folder Archived Mail or something else that’s easily recognizable. In 

older versions of Outlook, you can select File>Archive and change the date under Archive items older than.  

 
2. Create a new Archiving Rule. Click on Tools > Rules, select Exchange from the On My Computer section, and click the + near the 

bottom of the window. Name the rule something meaningful and recognizable, like “120 Days, Auto Archive.”            

 

3. Define the time limit and destination for emails eligible for archiving. Under the When a new message arrives menu, change Date 

Received (we suggest 120-180 days) and then change Do the Following to a defined action like “Move Message + Archived Mail.” 

Click the check box for Enabled and click OK. In older versions of Outlook, clicking Tools>Options>Other>Auto Archive brings up a 

similar set of options. 
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ADVANCED COMPUTERS 
5 STEPS TO ARCHIVE EMAILS AND KEEP OUTLOOK RUNNING STRONG - continued 

 

4. Run the new rule on existing email folders. If you set a new rule that all emails over six months old will be archived, 

don’t let aging messages received before that rule was implemented continue to clog up your Inbox. Select the preferred 

mail folder, click Messages>Rules>180 Day, Auto Archive, and wait patiently while your email account reorganizes itself. 

Remember, you’ll have to perform this function on each desired folder; also, Outlook uses “Last Modified Date” to 

archive, not “Received Date.” 

5. Want to access your archived emails? Simple — they’re waiting for you right on the left-hand column of folders — or 

under the list of .pst files on your computer — with all of your other mail folders. They’re no longer taking up space in 

your mailbox. 

 

 

 

 

 

 

 

 

 

Of course, archiving can’t cure all email diseases. If you access your mail via an Outlook Web App, any emails archived 

on your local computer won’t show up online — archiving them means they’re no longer hosted on the Exchange server. 

And a .pst file or archived folder stored on your local hard drive is still susceptible to disastrous data loss if it’s not backed 

up as part of your backup and disaster recovery (BDR) plan. 

Also, remember that Outlook is not a real email archiving solution — this tip will simply help you free up storage space 

within the program, NOT keep your email secure via offsite backup or searchable across years of accumulated messages. 

By end of Feb, instant $20 discount will be available when you mention you are from Seniornet for your outlook service 

at Advanced Computers.  

Please feel free to contact Advanced Computers team at 094448823 for more details. We open 6 days a week (Mon-Fri 

9:30am – 6pm, Sat 10am – 4pm). Looking forward to seeing you at our North Shore branch office, located at 7C Triton 

Drive, Rosedale. Ample parking is available.   



 

15 
 

A STITCH IN TIME 
PHOTOS FROM OUR NEW HANDCRAFT & STITCHING GROUP 
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TEKZONE TIPS 
HOW TO FIND YOUR WIFI PASSWORD IN WINDOWS 10! 

 
If you're running Windows 10 and don't know or remember your Wi-Fi password, but need 

it to connect another device or computer to the same network, it's easy to find that Wi-Fi 

password within your PC.  

 

1. Right-click the network icon on the toolbar.  Select open network and sharing centre. 

2. Click Change adapter settings. Right-click on the Wi-Fi network, and select status on the drop-down menu. 

3. Select Wireless Properties in the pop-up window. Click on the Security tab.  Check the box next to show characters to display 

the password. 

You can also use command prompt with 

“netsh wlan show profiles” to display all wifi 

profiles name and then “netsh wlan show 

profile name=your wifi profilename 

key=clear”  Look for the “Key Content” line to 

find the Wi-Fi password for that Wi-Fi 

network. 

 

 

 

  

mel@tekzone.co.nz 
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KNOWLEDGE 
TIPS TO AVOID SCAMS 

 

People in New Zealand are losing millions of dollars to scammers each year – and this is just the figures reported to 

Netsafe so the actual figure is likely much higher. There are often similar characteristics to most scams so we’ve put our 

advice together to help you. 

COVID-19 scams 

Scammers are using COVID-19 as the lure to engage people. While the scams are different in nature, they all have a 

common theme in that they are trying to obtain personal information and financial details. Netsafe is encouraging 

people to stop and think carefully before entering your details online, or giving them to someone.  It’s particularly 

important you protect information that can be used to access your accounts, build a fake online presence or impersonate 

you including: 

 Login details and passwords to any online 

account including banking, email, social media 

and trading sites 

 Bank account and credit card details 

 Address 

 Phone number 

 Birthdate 

 Personal information linked to the security 

questions on your online accounts 

 Driver’s license 

 Passport details 

Netsafe’s Guide to Scam Spotting 

An online scam is any scheme designed to trick people out of money or steal their personal information that uses, or is 

delivered via, digital communications. Here are a few tell-tale signs you might be being scammed: 

 Contact that is out of the blue – even if the person says they’re from a legitimate organisation like the bank, an 

embassy or your internet provider 

 Getting told there’s a problem with your phone, laptop or internet connections  – often they will offer to fix your 

device or say they are from your phone or internet company 

 Being asked for passwords – legitimate organisations will never ask for the passwords to your online accounts 

 Needing to verify your account or details – don’t respond or click on any links in the communication even if it 

looks like it’s from a real organisation 

 Trying to get you to move outside of an online trading or booking website or app (like Air BnB) – don’t pay 

outside of the normal website or app processes 

 Offering money or a prize in exchange for something up front – they might say that it’s a “processing” fee or 

something similar 
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 Being asked for money by friends/partners you’ve met online – this is a very common tactic, do not pay the 

money 

 Unusual ways to pay for something – scammers try to use payments that can’t be traced such as pre-loaded 

debit cards, gift cards, bitcoins, iTunes cards or money transfer systems 

 Asking for remote access to your device – never do this unless you have actively sought out the service they are 

providing 

 Pressuring you to make a decision quickly – this could be to avoid something bad (e.g. account being closed, 

trouble with the IRD) or to take advantage of something good (a deal or investment) 

Timing 

Often a scam works because of timing. For example, getting a call saying that there is a problem with your internet when 

you have actually been having problems with the connection. The best thing you can do when you notice any of the 

signs above is to stop, get some advice or look for more information. 

Doing your research 

You could also do some research to find information using some of the details you’ve been told. Try searching “problem 

with my computer scam”, “cheap concert ticket scam”, “verify my account email scam” or “NZ Chinese embassy scam” 

and see if the name of the organisation or person offering them appears. 

If the person contacting you has said that they are from a legitimate organisation and you’re not sure if it’s genuine, you 

can also contact that organisation to check. Make sure that you use the phone number or email they have on their 

official website or in the phone book – and do not use the one given by the person or in the email they have sent you. 

What are the worst scams? 

The scams that are most reported to Netsafe are scams like tech support scams, event ticket scams and cold calling 

scams. The scams where people lose the most money are usually romance scams, investment scams and invoice scams. 

Protecting your information 

Keep your personal information secure and be sure to think carefully before entering your details online, or giving them 

to someone.  Protect information that can be used to access your accounts, build a fake online presence or impersonate 

you including: 

 Login details and passwords to any online account including banking, email, social media and trading sites 

 Bank account and credit card details  

 Address 

 Phone number 

 Birthdate 

 Personal information linked to the security questions on 

your online accounts 

 Driver’s license 

 Passport details 
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PENSIVE PENCIL PUZZLES 
TRY YOUR HAND AT OUR MONTHLY PUZZLES 

 

SENIORNET NORTHSHORE SESSION WORDSEARCH 

  Q T Y A D I R F T S R I F D X

D R Z S W O D N I W M V S E U

V A K K G N I H C T I T S C G

O V P C L A S S E S A E E N E

T E N I L W P Q X E S V I A E

P L W R L E H H M R K Y R V R

P H O T O B O O K S A T O D O

P A H D E S T L B L T U M A H

O N E N E I O L P P U M E L S

H D M A F T G D Z L T N M E H

S C K S F E R N N E O K N A T

K R S P O A A C U H R I C R R

R A A I C Y P E P F O A T N O

O F O T E A H I E R A H S I N

W T U T O R Y G O L A E N E G

ADVANCED 

ASK A TUTOR 

ASK ME HOW 

CARD PLAYING 

CLASSES 

COFFEE 

FIRST FRIDAY 

FUN 

GENEALOGY 

HANDCRAFT 

HELP 

IPAD 

IPHONE 

LEARN 

MEMORIES 

NET 

NORTH SHORE 

PHOTO BOOKS 

PHOTOGRAPHY 

SENIOR 

SHARE 

STITCHING 

TEA 

TIPS AND TRICKS 

TRAVEL 

TUTOR 

WEBSITE 

WINDOWS 

WORKSHOP 

 

 A frog is at the bottom of a 30 metre well. It can climb up 3 metres during the day but slips back 2 metres each night. How many 
days does it take him to get out of the well?   

 A steam train leaves London heading towards Oxford at 80 Km/hour at exactly the same time a diesel train leaves Oxford heading 
for London at 120 km/hour. When they meet, which train will be closest to London? 

 A hunter walks 10 km due south, then 10 km due west and then 10 km due north - he is back where he started from - he fires a gun 
and kills a bear. What colour is the bear? 

 Mary's mum has four children. The first child is called April. The second is called May. The third is called June. What is the name of 
the fourth child? 

 A son and his real birth father were driving around and they got in an accident and the father died so the son gets brought to the 
hospital and the old doctor looks at him and says I can’t perform surgery on this kid he is my son! Who is the doctor? 

 If a plane crashes exactly on the border between America and Canada - where do you bury the survivors? 

 You're the pilot of an airplane that travels from New York to Chicago - a distance of 800 miles. The airplane travels at 200 m.p.h. and 
makes one stop for 30 minutes. What is the pilot's name? 

 A rope-ladder is hanging over the side of a ship. The ladder is 12 feet long, and the rungs are one foot apart. The lowest rung is 
resting on the top of the ocean. The tide rises at the rate of four inches per hour. How long will it take before the first four rungs of 
the ladder are under water? 

 How many grooves are there on each side of a LP record? 

 How much dirt is there in a hole 3 ft deep, 6 ft long and 4 ft wide? 

 Can you name three consecutive days without using the words Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, or 
Sunday? 

 A shop assistant at a butcher shop stands 1.89 metres tall and wears size 13 shoes. What does he weigh? 

 Before Mt. Everest was discovered, what was the highest mountain in the world? 

 What word in the English language is always spelled incorrectly? 

 If you were running a race and you passed the person in 2nd place, what place would you be in now? 

 A woman had two natural born sons (neither were adopted) who were born on the same hour of the same day of the same year. 

TRICKY QUESTIONS 
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MY EYES DECEIVE ME 
GET A WIGGLE ON 

 

The horizontal lines can play some major tricks on you. Can you 

see the horizontal patterns across the image as a mixture of 

rounded squiggles and straight line zig zags?   

If you can, your eyes are deceiving, you! All the lines are a 

repeating pattern of rounded squiggles – no straight line zig 

zags! The effect is known as the “curvature blindness illusion.” 

As the name suggests, you become blind to the curves 

illustrated above because of the contrast created by the 

background. 

 

LOST & FOUND 

Left in our clubrooms – Avalon Waterways Cruise Memories 

folder – if it’s yours contact Lois by email … lois.kay@xtra.co.nz 

 

 


